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In This Version 

For information about the differences between HP OpenView Service Desk 4.5 and HP OpenView Service 
Desk 5.0, refer to HP OpenView Service Desk 5.0 Differences Between 4.5 and 5.0. 

The Extraction Configuration Wizard (ECW) was included by mistake in Service Desk 5.0. ECW is not 
supported in service Desk 5.0, so it is not included in Service Desk 5.0 Service Pack 1. 

Service Pack 1 and the integration software released separately include the following new features: 

• Web Console. 

• The ability to integrate with HP OpenView Self-Healing Services. 

• The ability to integrate with the following products: 

⎯ HP OpenView Internet Services (OVIS) 

⎯ HP OpenView operations (OVO) 

⎯ Microsoft Operations Manager (MOM) 

 

NOTE: The integrations for Microsoft Systems Management Server (SMS) and HP OpenView 
Network Node Manager (NNM) will be released with Bundled Component Ugrade 2 (BCU2). 

 

For information about the versions of the integrated products Service Desk can integrate with, refer to the 
Supported Platforms list at this URL: http://openview.hp.com/ecare/getsupportdoc?docid=OV-EN018535. For 
information about OVO, refer to the HP OpenView Service Desk OpenView Operations Integration 
Administrator’s Guide. For information about the other integrations, refer to the HP OpenView Service 
Desk Data Exchange Administrator’s Guide.      
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Documentation Updates 
The first page of this document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates, or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name.  

2 In the Version list, click the version number.  

3 In the OS list, click the OS type.  

4 In the document list, click the document title.  

5 To retrieve the document, click Open or Download.  

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following URL:  

http://www.adobe.com

In Service Desk 5.0 Service Pack 1, the HP OpenView Service Desk Concepts Guide will be available. 

The HP OpenView service Desk OpenView Operations Integration Administrator’s Guide will be 
available with the release of the OVO integration, and an updated HP OpenView Service Desk Data 
Exchange Administrator’s Guide will also be available when the other integration software is released. 

Documentation Errata 
This section describes the following: 

•  Any errors in the published documentation 

•  Latest information that could not be included in the published manuals or online help 

Errors in Online Help 

Command Line Utility 
Topic ID: UiCaCommandLine 

Title: Command Line Utility 

Location: Information for Administrators>Command Line Utility 

This help topic contains an error. 

Incorrect Text: “In a help desk environment, for example, you might have a tool that pulls a caller's phone 
number from the phone system. Using the console command line utility, you could write a script that would 
display a view containing all calls in the HP OpenView database that originated from this caller's phone 
number.” 
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Problem: The command line utility, ovconsolecmd, cannot parse variables passed to it. This functionality 
is not available for Service Desk 5.0 Service Pack 1. 

Active Directory User Authentication 
Topic IDs: SecLoginAdssologinModule, SecLoginAdssoTokenValidation 

Location: Information for Administrators>Users & Security>User Authentication>Active 
Directory User Authentication 

Defect number: QXCR1000328248

Problem: Information is out of date. NOTE: Active Directory Token Validation is supported only on 
Windows and HP-UX operating systems.  

The following information supplements the section entitled Active Directory User Authentication.  

In the topic Configure the Active Directory Log-in Module (topic id: SecLoginAdssoLoginModule), 
step 5 is expanded with the following additional options: validateServer, servicePrincipal, and keyTab. 
(the existing option, debug, remains unchanged): 

• validateServer - Whether to validate the token that the management server receives from the console. 
Set this to “true” or “false”. (Default is “false”.) If you set this to “false”, the management server assumes 
that the token is valid, and security decreases. Therefore, you are recommended to set this to “true”. 

• servicePrincipal - The name of the service principal that the management server uses when it 
validates tokens. Use the format “<service principal name>@<ACTIVE DIRECTORY DOMAIN>”. 
(Default is “OVLOGIN/<management server hostname>@<realm>”.) 

• keyTab - The full path to a keytab file, using forward slashes (/) as path delimiters. The keytab file 
contains credentials of a user that the management server uses when it connects to the Active Directory 
server to validate tokens. By default, this option has the following value: 

⎯ Windows operating systems: <data_dir>/conf/sec/login/ovlogin.keytab 

⎯ UNIX operating systems: /var/opt/OV/conf/sec/login/ovlogin.keytab 

• debug - Whether to output debug information. Set this to “true” or “false”. (Default is “false”.) 

The following additional topic explains how to set up token validation. 

Configure Active Directory Token Validation 

If you configure a management server to authenticate users with Active Directory, the management server 
requests the users’ existing log-in context from the console when the user attempts to log in. The console 
then returns a token. 

To enable the management server to validate this token, you must complete the following tasks: 

• Configure a user and service principal on your Active Directory server. 

• Copy a keytab file for this service principal onto your management server. 

• Configure client systems to send session keys. 

NOTE: The configuration steps in this topic involve software provided by Microsoft Corporation: Active 
Directory, the command ktpass, and Registry Editor. Attempt to complete these steps only if you have 
appropriate expertise and permissions. If you are unable to complete these steps, it is still possible to 
configure Active Directory user authentication by not setting the validateServer option to “true” when you 
configure the Active Directory log-in module. However, doing this decreases security. 

To configure a user and service principal: 

1 On the Active Directory server, create a user account with a logon name that corresponds to the host 
name of your management server. For example, if the management server’s fully qualified domain name 
is management1.example.com, create a user with logon name management1. 
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2 Check the account properties to ensure the account meets the following requirements: 

• A password change at the next logon is not required. 

• Kerberos preauthentication is required. 

3 Use ktpass to map a service principal name to the new user and create a keytab file. By default, the 
Active Directory log-in module expects the service principal name in the following format:  

OVLOGIN/<management server hostname>@<ACTIVE DIRECTORY DOMAIN> 

The following example maps a service principal name to a user called management1 where the 
management server hostname is also management1 and the Active Directory domain is 
EMEA.EXAMPLE.COM. The example creates a keytab file called ovlogin.config. 

ktpass -mapuser management1 -princ  

OVLOGIN/management1@EMEA.EXAMPLE.COM -pass secret -out  

ovlogin.keytab 

If you need to use a different service principal name, set the servicePrincipal option when you configure 
the Active Directory log-in module. 

To copy a keytab file for your service principal: 

Securely copy the generated keytab file from your Active Directory server to your management server. Save 
the keytab file in the following location on the management server: 

• Windows operating systems:  

<data_dir>\conf\sec\login\ovlogin.keytab 

• UNIX operating systems:  

/var/opt/OV/conf/sec/login/ovlogin.keytab 

If you need to use a different file name or location for the keytab file, set the keyTab option when you 
configure the Active Directory log-in module. 

To configure client systems to send sessions keys: 

NOTE: To use Active Directory user authentication, each client system must be able to send to the 
management server a ticket-granting ticket (TGT) that contains a valid session key. If the client runs the 
Windows XP SP2, Windows Server 2000 SP4, or Windows Server 2003 operating system, the TGT does not 
contain the required session key by default. To change this behavior, you must create a registry key. 

1 On the client system, use Registry Editor to locate the following key: 

• Windows XP SP2 operating system:  

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Lsa\Kerberos\ 

• Windows Server 2000 SP4 and Windows Server 2003 operating systems:  

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Lsa\Kerberos\Parameters 

2 Create a new value with the following attributes: 

• Name: allowtgtsessionkey 

• Type: REG_DWORD 

• Value: 1 (decimal) 
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HP OpenView Performance Insight 

To use HP OpenView Performance Insight with Service Desk 5.0, you need to purchase the following 
components: 

• HP OpenView Performance Insight 5.1 

• HP OpenView Performance Insight Database Connector (one for each Service Desk server you want to 
report from) 

• Your choice of the following: 

⎯ HP OpenView Performance Insight Report Pack for Helpdesk Manager 

⎯ HP OpenView Performance Insight Report Pack for Change Management 

⎯ HP OpenView Performance Insight Report Pack for Service Level Management 

• Media and Manuals for HP OpenView Performance Insight are purchased separately.  The manuals are 
available in PDF format on the CDs. 

There is a starter bundle, HP OpenView Performance Insight Starter Bundle for Service Desk 5.1. This 
includes: HP OpenView Performance Insight 5.1, HP OpenView Performance Insight Database Connector, 
and the HP OpenView Performance Insight Report Pack for Helpdesk Manager. 

Prerequisites 
Database 

OVPI 5.1 supports only Oracle 9.2.0.5 with the “partitioning feature” configured. 

Note: Windows XP is not supported. 
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Installation Notes 
The following install scenarios are supported: 

• Fresh  

• Upgrade 

• Secondary server 

For more details, refer to the HP OpenView Service Desk 5.0 Installation Guide. 

Note the following potential problem regarding HP-UX. 

A Problem Arises When the Software DVD-Rom Is Mounted on HP-UX 

Problem 

A problem arises when the software DVD-Rom is mounted on HP-UX. 

Workaround 

To mount the DVD-Rom on an HP-UX system, use the following commands: 

nohup pfs_mountd& 

nohup pfsd& 

pfs_mount -o soft <DVD-Rom ID> /cdrom 

DVD-Rom ID is the ID of your actual DVD-Rom. 

You can find this ID by using the following command: 

ioscan -funC disk 

Software and Hardware Requirements 

Before installing HP OpenView Service Desk 5.0, make sure that your system meets the following minimum 
requirements:  

• OS platform and compatibility  

⎯ Supported operating systems  

⎯ For information about the supported operating systems, and corresponding system requirements, 
refer to the HP OpenView Service Desk 5.0 Installation Guide.   

⎯ Operating system patches required for Sun Java  

The operating system of the machine on which Service Desk will be installed must be upgraded with 
the most recent operating system patches related to the Java Runtime Environment (JRE). Failure 
to install these patches may result in one or more subsequent components failing to install. This 
problem is especially critical on HP-UX 11. 

Patches should be installed before you install the Java software. Some patches are absolutely 
necessary to run Java; others are recommended for optimum performance. HP recommends that you 
install all patches needed for your system configuration. 

• Software  

⎯ Database server  
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For information about supported databases, refer to the HP OpenView Service Desk 5.0 Installation 
Guide. 

The use of the Unicode character set AL32UTF8 is recommended on Oracle. If you want to use the 
Unicode character set as your default character set, you must create the Oracle instance for 
supporting Unicode. 

For an Oracle Database, you should possess the appropriate rights (DBA account and password) for 
creating new Oracle Database users. 

⎯ Microsoft SQL Server configuration  

Configure Microsoft SQL Server to accept non-Windows user name and password logons. You can 
configure this acceptance in the properties window of the SQL Server instance. Set the 
Authentication to “SQL Server and Windows.” 

NOTE: If you have installed a previous version of HP OpenView Service Desk, remove the 
OVXPL_DATA_DIR, OvDataDir and OvInstallDir environment variables before reinstalling. 

Installation Problems 

This section provides workarounds to known installation problems. 

Installation Problems on Solaris 9 and 10 
Problem 

On Solaris, a “Finalize action warning” error is displayed at the end of the installation. The application 
installer tries to start all the processes and the ovobs process fails.  

The error message states the following: 

Finalize action for HP OpenView Service Desk Management  

Server (Starting the server.) was not successful. 

The following shows the status after the installation: 

Ovcd        OV Control                CORE         (2434)   Running 

ovbbccb     OV Communication Broker   CORE         (2435)   Running 

ovloginsv   OV Login Server           JAVA                  Stopped 

ovapacheA   OV Apache(A) WebServer Service   WEB            Aborted 

ovsdma      OV SLM OVSD Metric Adapter SLM         (2757)   Running 

ovtomcatA   OV Tomcat(A) Servlet Container   WEB   (2625)   Running 

ovsdslm     OV Service Level Management SLM        (2762)   Running 

ovobs       OV Object Server            OBS                 Aborted 

ovcs        OV Certificate Server       SERVER     (2763)   Running 

ovsdreport  OV Service Desk Reporting   SDREPORT            Aborted 

This problem is linked to the value of the timeout of the OV Control process, which is too small for Solaris 
systems.  

Workaround: 

Enter the following commands: 

1 ovc –kill 

2 ovconfchg -ns ctrl.ovcd -set ACTION_TIMEOUT 120 

3 ovc -start 
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QXCR1000315787:  
Apache Startup 
Problem 

For all UNIX systems in a NIS-controlled environment, the OvApacheA package, installed during the 
Service Desk Management Server installation, does not create the user ovwebusr and the group 
ovwebgrp. To solve this, manually create the user ovwebusr and the group ovwebgrp on the Network 
Information Service (NIS) server after installing the OvApacheA product and before starting the OvApacheA 
WebServer service. 

Workaround 

1 Add a group:  

groupadd ovwebgrp 

2 Add the ovwebusr group: 

 useradd -G ovwebgrp ovwebusr 

3 Restart the Apache process: 

ovc -start ovapacheA 

Installation Freezes 
Problem 

If the installation screen remains static for a very long time, your machine may have frozen. 

Workaround 

To prevent the installation from freezing, follow these steps: 

1 Download scripten.exe from the Microsoft web site: 

www.microsoft.com. 

2 Run the scripten.exe file. 

3 Restart your computer. 

4 Run the setup.exe file again. 

Error Messages in the Log Files 
Problem 

You encounter error messages in the following log file: 

C:\Program Files\HP OpenView\data\log\system0.0.en_US 

Example: 

Oct 18, 2005 9:01:48 AM;5;10;com.hp.ov.obs;SEVERE;SQL Exception: JDBC error 942: ORA-00942: 
table or view does not exist, SQL state: 42000 for query: select 1 from 
itsm_personsjava.sql.SQLException: ORA-00942: table or view does not exist 

Workaround 

None. Do not be alarmed. These messages do not impact the behaviour of the application. 
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QXCR1000312290: 
Unable to Depersist an Object 
Problem 

The following message appears in the system0.0.en_US log file: 

Jan 19, 2006 4:20:52 PM;99;19;com.hp.ov.obs;SEVERE;Unexpected error  

deserializing a JavaObject. Exception: {0} 

java.io.StreamCorruptedException: Unable to depersist an object  

(com.hp.ov.ui.ext.core.view.chart.ChartViewInfo). 

null 

        at com.hp.ov.obs.util.Streamer.readObject(Streamer.java:365) 

        at com.hp.ov.obs.util.Streamer.readObject(Streamer.java:100) 

        at com.hp.ov.obs.util.ObsUtils.deserialize(ObsUtils.java:901) 

        at com.hp.ov.obs.util.RsObjectValue.getObjectValue 

Workaround 

You can safely ignore this message. It does not indicate a severe problem with the software. 

QXCR1000320074: 
JVM Memory Consumption 
Problem 

When using Service Desk 5.0, you might see some unusual traces in the log file, as shown in the following 
example: 

Feb 28, 2006 10:31:49 AM;142;18;com.hp.ov.obs;SEVERE;JVM uses  

518,979,584/518,979,584= 100% of maximum memory (total/max) of which  

322,468,824/518,979,584= 62% is free (free/total). 

Feb 28, 2006 10:33:49 AM;143;18;com.hp.ov.obs;SEVERE;JVM uses  

518,979,584/518,979,584= 100% of maximum memory (total/max) of which  

296,562,824/518,979,584= 57% is free (free/total). 

Workaround 

Change the maximum memory used by the Object Server process: 

1 Edit the file called OvObs.xml. 

Location on Windows: C:\Program Files\HP OpenView\data\conf\obs 

Location on UNIX: /var/opt/OV/conf/obs  

2 Change -Xmx512m  to -Xmx1024m, and save the changes. 

3 Unregister Object Server by using the following command: ovcreg -del ovobs 

4 Register Object Server again by using the following command:  

Windows: ovcreg -add C:\Program Files\HP OpenView\data\conf\obs\OvObs.xml 

UNIX: ovcreg –add /var/opt/OV/conf/obs/OvObs.xml 

5 Start Object Server by using the following command: ovc -start 
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Uninstall Steps (Windows Only) 

This section describes how to uninstall HP OpenView Service Desk 5.0, and remove its files, on Windows 
systems. 

Uninstall Service Desk 
To remove a Service Desk component from your Windows system, do the following: 

• In the Windows Control Panel, select Add/Remove Programs. 

After you have uninstalled the software, remove the Service Desk files and the Self-Healing Services registry 
key. 

Remove Service Desk Files 
Warning: Perform the following cleanup operation only if Service Desk 5.0 has been previously installed on 
your system, and only if you do not have other HP OpenView products (for example, HP OpenView Internet 
Services) installed. 

To remove Service Desk 5.0 files, follow these steps: 

1 Delete the location where you installed the software. 

The default install location is as follows: 

C:\Program Files\HP OpenView 

2 Delete the HP OpenView registry key: 

HKEY_LOCAL_MACHINE\Software\Hewlett-Packard\HP OpenView 

3 Remove the following services: 

⎯ HP OpenView Shared Trace Service 

⎯ HP OpenView Apache(A) WebServer Service 

⎯ HP OpenView Ctrl Service 

⎯ HP OpenView Tomcat(A) Servlet Container Service 

⎯ HP OpenView Communication Broker 

4 Delete the following folder: 

C:\Documents and Settings\%USERNAME%\Application Data\HP OpenView 

5 Delete the following environment variables: 

⎯ OvDataDir 

⎯ OvInstallDir 

⎯ OvXpl_data_dir 

⎯ WAPP_HOME 

6 In the %PATH% environment variable, remove the following reference: 

C:\Program Files\HP OpenView\bin 

7 In the %TEMP% folder, delete the ovinstallparams.ini file. 

8 Reboot the system. 

Remove Self-healing Services Registry Key 
For information, refer to QXCR1000329577 in this document. 
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Enhancements and Fixes 
This section describes any major new features in this release, and the fixes for defects raised by customers. 

Enhancements 

HP OpenView Service Desk Service Pack 1 contains a new feature: the Web Console. For documentation 
ole, refer to the HP OpenView Service Desk Administrator’s Guide. 

It is also now possible for Service Desk 5.0 to integrate with HP OpenView Self-Healing Services. 

ion 
, and it is included in 

about the Web Cons

Self-Healing Services software can be used to gather and submit data necessary to streamline the resolut
of problems found in Service Desk 5.0. HP recommends the use of Self-Healing Services
every support contract. Documentation and downloads are available at 
http://support.openview.hp.com/self_healing.jsp. 

Fixes 

This service pack contains the following fixes: 

Short Description Defect Number 

QXCR1000284568 Authentication should be case-insensitive. 

QXCR1000297062 lable in Format rules of Views. ‘To deadline’ not avai

QXCR1000301842 Calendar controls do not work. 

QXCR1000302073 The 'Match case' option is not available in Advanced Find yet. 

QXCR1000305153 Cancel form does not cancel changes. 

QXCR1000306115 UI Rule blocks DB Rule. 

QXCR1000306288 Question over ovconsolecmd. 

QXCR1000306291 Missing Relations when using system action “Create Work Order” 

QXCR1000306771 In DB and UI rules criterion’s on classification doesn’t show values. 

QXCR1000306785 Chart view by month causes classcastexception. 

QXCR1000306815 Cannot save record. The attribute OID must be unique. 

QXCR1000309086 Entities with view access only generate query builder errors on history. 

QXCR1000309175 The Quick Find window cannot open again, in click close icon in the 
Quick Find. 

QXCR1000309636 Problem when using offsets for dates in templates. 

QXCR1000310151 r for this operating system is not enabled”. “Your installe
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QXCR1000313147 Configuration item map shows all related CIs. 

QXCR1000315387 Problem with import mappings on the custom fields. 

QXCR1000317617 Database Export/Import possible using OvObsConfig. Is this supported? 

QXCR1000317950 Cannot use %line.separator% in Database rules. 

QXCR1000321016 OVConsoleCmd in Smart Action cannot use quotes in Smart Action 
parameters. 

QXCR1000302856 Modified role only propagated when server cache is cleared. 

QXCR1000304295 or: Query Builder cannot join tables. Query manager gives err
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Known Problems, Limitations, and Workarounds 
This section describes known problems, limitations, and related workarounds for Service Desk. 

General Problems 

This section describes how to work around general problems you may encounter with Service Desk. 

Incorrect Messages in the Log Files during Installation 
Problem 

In the system0.0.en_US log file, the following message appears twice consecutively: 

"com.hp.ov.obs.security;SEVERE;441No Passwords in License File error code: 5997" 

Workaround 

You can safely ignore this message. It does not indicate a severe problem with the software. 

Problem 

During the installation of Service Desk 5.0 on Solaris, in the system0.0.en_US log file, the following 
message appears: 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdma.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvsdMA.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvSdSlm.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdslm.xml'. 

Workaround 

You can safely ignore this message. It does not indicate a severe problem with the software. 

Log-on Exceptions 
Problem 

After you install Service Desk, you encounter a log-on exception.  

Workaround 

Before using the Secure Socket Layer logon, execute the OvObsClientSettingsEditor.bat file. 

Failure to execute this file results in the following error message: 

Javax.security.auth.LoginException: Failed to login due to RpcException: unexpected HTTP 

status: 503 Service Unavailable. 

For information on the user authentication mechanisms available, including the use of the Lightweight 
Directory Access Protocol (LDAP) and Active Directory, refer to the Service Desk online help (in the 
Contents tab of the Help Navigator window, see the section Information for Administrators>Users & 
Security, and see the topics in the sections on User  Authentication, Principal Mappings, and 
Accounts).  Note: for some of the latest information about Active Directory user authentication, refer to 
Active Directory User Authentication in this document.   
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QXCR1000329577 
Self-Healing Registry Key Remains after Service Pack 1 is Installed 
Problem 

A registry key remains after Service Desk is uninstalled. 

Workaround 

Manually remove the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\SH Services\Supportability Adapter\dc 

The value is SDESK. 

QXCR1000289191:  
Help Only Available When Using the Default Port 
Problem 

The online help is not available when Apache is installed on a non-default port. Because the application 
installer offers you the option to set another port for Apache, this problem could affect you. 

Workaround 

None. 

QXCR1000244984:  
Incidents Generated by the Alarm Engine are Not Correctly Filled 
Problem 

For all incidents created by the alarm engine, the associated service level is not correct. It is always the 
same service level for all the incidents. 

Workaround 

You can modify the configuration item (CI) linked to the incident. Because the incident is created 
automatically for the specific CI, the user should not be able to modify the CI. 

Expected behavior: 

• Service level must be set with the right service level name. 

• User cannot modify the value of the incident’s CI field. 

QXCR1000283641:  
Searching for Text from “Localized Text” Does Not Work 
Problem 

By default, it is not possible to search for text in Localized Text or its subfolders.  

Note: If you select one of the subfolders of Localized Text, and run Advanced Find, this subfolder becomes 
available to the search engine, and is added as a searchable folder in Advanced Find, added to the bottom of 
the list. These changes are lost again after restarting the console. 

To reproduce the problem: 

1 Click OV Configuration→Presentation→Localized Text, and select the Localized Text folder. 

2 Open the Advanced Find form by pressing F2 or clicking Advanced Find in the menu bar. 

3 Search for localized text in Localized Text and in one of its subfolders. 
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Expected Results 

The Advanced Find form opens. The Show field contains Localized Text, and you can select one of its 
subfolders (for example, Label Text). You can run a search in Localized Text and in one of its subfolders. 

Actual Results 

Pressing F2 does not open the Advanced Find form. Clicking the Advanced Find button in the menu bar 
opens Advanced Find, but Localized Text and its subfolders are not available to the search. They cannot be 
selected in the Show field. 

Workaround 

None. 

QXCR1000289979:  
No Data is Presented on a Java Web Start Client after an Object Server Failover 
Problem 

No data is presented on a Java Web Start client after an Object Server failover. 

Prerequisites: 

Two management servers installed refer to one database. 

To reproduce the problem, follow these steps: 

1 Start two Java Web Start clients on two different machines, referring to different management servers. 

2 Stop one of the management servers. 

Expected Results 

After the failover, the Java Web Start client that referred to the stopped management server is connected 
automatically to the running management server. All data is still accessible.  

Actual Results 

After the failover, the Java Web Start client that referred to the stopped management server is connected 
automatically to the running management server. Data is not accessible anymore. Data creation is no longer 
possible. 

Solution 

Download the Java Web Start client again by using the URL connecting the second application server. 

Service Pages Installation Hangs If Apache and Tomcat are Already Running 
Problem 

When trying to install Service Pages, the installer hangs and does nothing. 

Prerequisites 

A system for Service Pages, with the Apache web server and Tomcat Servlet container already running. 

To reproduce the problem, attempt to install the Service Pages installer. 

Expected Results 

The installer runs, and the installer splash screen appears.  

Actual Results 

Nothing happens. The installer interface does not appear. 

Workaround 

Stop Apache and Tomcat before running the installer. 
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QXCR1000294601:  
Service Level Created from Java Web Start is Not Visible on OvConsole 
Problem 

The service levels created on the Java Web Start console are not visible from OvConsole. 

To reproduce the problem, follow these steps: 

1 Start Java Web Start. 

2 Create one service level. 

3 Start the HP OpenView console. 

4 Open the list of the service levels. 

You cannot see the service level created with the Java Web Start console.  

Workaround 

It is recommended that you reconnect to see other entities. The problem may be fixed after service levels are 
not cached any more. If a client updates a cached entity, other connected clients do not automatically update 
their cache. This design decision was made for performance reasons. Cached entities should be fairly static. 
At the time, the functional impact was considered to be low. 

QXCR1000242246:  
{I18N} Apache Service is Not Registered in the OS When Installed in a Non-ASCII Path 
Problem 

When a Service Desk installation includes an Apache server (such as the Service Desk 5.0 Server 
installation), and is installed in a path that contains non-ASCII characters (for example Chinese, Japanese, 
or Russian), the Apache server is not installed properly.  

As a result, all functionality that relies on the Apache server does not work: 

• Java Web Start client 

• Web UI 

• Service Pages 

• Attachments 

• Online help 

Workaround 

None. 

QXCR1000244548:  
Traces Using Java Web Start 
Problem 

When a client is deployed using Java Web Start, some logs are not recorded. 

Some of the graphical user interface log messages are logged in the Object Server log file. 

Workaround 

None. 
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Service Level Management 

This section describes known problems, limitations, and workarounds related to Service Level Management 
(SLM) in Service Desk. 

Metric Adapters: Tuning the Query Limitations 
Problem 

The query restriction in the HP OpenView console can be set to display a maximum of 500 metric definitions 
and 1000 metrics. The query restriction is required to use OVPA metrics or any other metrics with big 
volumes. 

Workaround 

To disable the query restriction, follow these steps:  

1 In the OV Configuration workspace, select Presentation. 

2 In the panel, select Search.  

3 Double-click and select No restriction (instead of Restricted to) for each of the following objects:  

⎯ Metric Definition  

⎯ OVxx Metric  

⎯ OVxx Metric Definition  

QXCR1000244984:  
Incidents Generated by the Alarm Engine Are Not Correctly Filled 
Problem 

When an incident is generated by the SLM Alarm Engine, its service level attribute is not related to the 
generation of the incident. 

Instead, the service level determination works as follows: 

• If the related configuration item has a service level, that service level is taken. 

• If not, the default service level is used. 

Workaround 

None. 

QXCR1000316864:  
Severe Errors in Join Tables Operation 
Problem 

Severe errors are logged in the Object Server log file. All the errors are related to a Join Table Operation. 
The severe errors associated with the query builder error on join tables are generated when you try to 
remove a service definition that has an associated service.  

The following traces will be created in the log files: 

Feb 10, 2006 3:24:39 PM;99;11;com.hp.ov.obs;SEVERE;Error 

com.hp.ov.obs.impl.util.DeveloperException: Query Builder can not join tables cdm_services 
[281478426132597] and cdm_services_x [272934308553576458]. 

Check relations between cdm_services on one hand, and cdm_services_x and cdm_services_x on 
the other. in method createReferencedTable 

 at 
com.hp.ov.obs.impl.da.AppQueryBuilder.createReferencedTable(AppQueryBuilder.java:1392) 
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 at com.hp

 at com.hp.ov.obs.impl.da.AppQueryBuilder.listWhereParts(AppQueryBuilder.java:2595) 

.ov.obs.impl.da.AppQueryBuilder.makeJoin(AppQueryBuilder.java:2025) 

You can safely ignore these traces because they do not indicate any severe problem with the software. 

1000299666:  
ssages Sent to the Client Console 

LM licensing problem occurs, no message is sent to the client console, but all licence events are 
e SLM log file. For example, if the number of services authorized by licenses is reached, you can 

e other services are not managed. 

Web Start 

scribes known problems related to Web Start deployment. 

oy the Service Desk 5.0 Client from a UNIX to Windows system by Web Start, the names’ 
must be consistent.  

ot have any inconsistency between the full internet name and the alias name. For 
 use http://myhostname.domain.org/ovconsole

 at com.hp.ov.obs.impl.da.AppQueryBuilder.listWhereParts(AppQueryBuilder.java:2610) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.createConcreteQuery(AppQueryBuilder.java:335) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.createQueryBuilder(AppQueryBuilder.java:223) 

Workaround 

None. 

QXCR
SLM Licensing: No Me
Problem 

When an S
logged in th
create a new service, but the SLA Activity Status remains not managed. 

SLM manages only the number of services licensed. If a greater number of services are ready in the CMDB 
for SLM management, only a licensed number of services are managed. Th
The non-managed services are listed only in the log file, and the SLM management status may be 
inaccurate. 

Workaround 

None. 

This section de

QXCR1000305148: 
Starting SD 5 Client Deployment using Web Start 
Problem 

If you depl
resolution 

Workaround 

Make sure that you do n
example, if you   (full internet name) as a command for 
downloading the Service Desk 5.0 Client on Windows, the deployment will fail if, on UNIX, the result of 
“hostname” is myhostname (alias name). 
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Smart Actions 

This section describes known problems related to Smart Actions. 

QXCR1000309377: 
Smart Action Create Work Order in Service Call Generates Error Message 
Problem 

Open a Service Call form and start the Action Create Work Order. This generates the following error 
message: 

Windows cannot find 'Files/HP'. Make sure you typed the name correctly, and then try again. 
To search for a file, click the Start button, and then click Search. 

Every time the UI rule condition is met, an error occurs. 

 Workaround 

In the OV Configuration workspace group, click Actions and Rules >Applications. 

Select Service Desk Form and change the command line. The default value of the Command line field is 
call "$PRODUCTFOLDER$\bin\ovconsolecmd.bat". Remove the call command from the command line. 

QXCR1000324443:  
Smart Actions Pass ID Parameters in Wrong Format 
Problem 

Create a smart action that passes an ID as a parameter to an external command.  

Use the external command echo %* on Windows, or echo $* on UNIX. 

Make sure the ID is greater than 1000.  

When the ID is greater than 1000, the GUI shows commas between the thousands (or a period, depending on 
the locale), for readability. The smart action passes the ID as a parameter in the same format, that is, with 
commas. This is wrong. 

An example where this results in errors is when the smart action invokes a script that sends the results 
back to Service Desk by using LoadObject. LoadObject uses the ID to identify the entity to modify. However, 
LoadObject expects an ID without commas. 

Expected Results 

The ID parameter must be passed without formatting, that is, without characters that improve readability. 

External interfaces like smart actions and LoadObject must use the same formatting of parameters. 

Workaround 

The script called by the smart action should remove the formatting of the ID before further processing. 

This workaround is only applicable for smart actions that call a script that can be modified. 

If you call a 3rd party executable, this workaround will not work. 
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OVO Integrations 

This section describes known problems, limitations, and workarounds in the HP OpenView Operations for 
Windows (OVO/W) and HP OpenView Operations for UNIX (OVO/U) integration packages of Service Desk. 

QXCR1000330226: OVO/W-SD Integration: 
Service Desk Database Rule Not Triggered 
Problem 

When an incident is set to state=closed, the database rule that sends an acknowledgement to the OVO/W 
management server is not triggered. 

Workaround 

Create a new dummy rule, save it and delete it. 

QXCR1000323681: OVO/W-SD Integration:  
Integration Account in OvObsLoadObject.conf Cannot Create Incidents  
Problem 

Integration account does not allow OVOW messages to create incident records in Service Desk. 

Workaround 

Manually modify the OvObsLoadObject.conf file. Move the line with the entry SERVER to the line just 
below [OVOBSLOADOBJECT]. 

The delivered configuration file OvObsLoadObject.conf contains the following lines: 

[OVOBSLOADOBJECT] 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 

ACCOUNT=OVOW_server1/Password4OpenV!ew 

SERVER=sdmanagementserverhostname 

PORT=30980 

MAPPING=ovowindows 

CLASSNAME=incident 

MODUS=insert 

Change the contents of the file to the following: 

[OVOBSLOADOBJECT] 

SERVER=sdmanagementserverhostname 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 

ACCOUNT=OVOW_server1/Password4OpenV!ew 

PORT=30980 

MAPPING=ovowindows 

CLASSNAME=incident 

MODUS=insert 
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QXCR1000314392: OVO/W-SD Integration:  
Monitor Service Desk Log File Policy' does not Work 
Problem 

This policy does not work. There are two issues.  

1 %OvDataDir% is not the correct syntax. Therefore, this variable is not replaced and the file cannot be 
found.  

2 The policy assumes there is only one Service Desk log file, but there are several. You could use HP 
OpenView Operations’ log file preprocessing to get a list of all the log files and to monitor all the log files. 

Workaround 

1 You should use <$OvDataDir>\log\servicedesklogfile in the policy, where servicedesklogfile is the name 
of a log file. 

2 To monitor multiple log files, create in OVO/W a log file monitoring policy for each log file. 

QXCR1000314396: OVO/W-SD integration: 
'Monitor sd_event Log File Policy' does not Work 
Problem 

This policy does not work. There are three issues:  

1 %OvDataDir% is not the correct syntax. Therefore, this variable is not replaced and the log file cannot be 
found. 

2  Error messages are not logged in the OvObsLoadObject.log log file mentioned in the policy. 

3 The policy uses Read from beginning (always). 

Workaround 

1 To search for server errors, in the “Monitor sd_event Log File” policy, use <$OvDataDir>. 

2 Change the file name <$OvDataDir>\log\OvObsLoadObject.log to 
<$OvDataDir>\log\OvObsLoadObject_error.log. 

To search for server errors, use the following pattern: 

SERVER RESPONSE=<*.ServerError>  

To search for client errors, use the following pattern:  

CLIENT_ERROR=<*.ServerError> 

3 Change the policy by selecting Read from beginning (first time).  

QXCR1000333600: OVO/U-SD Integration: 
Database Rules Cannot be Modified Straight after Import 
Problem 

Modifying the database rules that are uploaded into Service Desk during the configuration of the integration 
might result in the following error: 

Could not show dialog(com.hp.ov.obs.admin.rules.db.form.DBRuleWizard). 
java.lang.NullPointerException 

Workaround 

Restart the Service Desk server processes with the commands: ovc –stop and ovc -start. 
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QXCR1000337260: OVO/U-SD Integration: Scheduled Outage with Monthly Recurrence Not 
Supported 
Limitation 

Scheduled outages (also known as planned outages) are defined by using schedule elements. Although you 
can define daily, weekly, and monthly recurrence patterns for a schedule element in Service Desk, only daily 
and weekly recurrence patterns are supported for outage used by the OVO for UNIX Integration. 

Workaround 

None. 

QXCR1000338573: OVO/U-SD Integration: Outage Schedules and Schedule Elements Cannot 
Contain Spaces 
Limitation 

The names of schedules and schedule elements used for defining outages (also known as planned outages) 
for the OVO for UNIX Integration cannot contain spaces. If the name of a schedule or a schedule element 
contains one or more spaces, the outage file will not be updated.  

The log file will show the error message: No data found for parameter Simple schedule: <Schedule 
Element name until first space> to be written to the outage-template file or No data found for 
parameter Compound schedule: <Schedule name until first space> to be written to the outage-
template file. 

Workaround 

When you define schedule and schedule elements for use with OVO/U outage, use names that do not contain 
spaces. 

QXCR1000346943: OVO/U-SD Integration: Obsolete Downtime Schedule is Not Removed 
from OVO Outage File 
Limitation 

After deleting an obsolete Planned Downtime schedule from the Downtime tab of a configuration item, the 
schedule is not deleted from the outage file on the OVO Management Server. The same problem also occurs 
for Occasional Outage. 

Workaround 

Obsolete outage information must be manually deleted from the outage file on the OVO Management 
Server. 

QXCR1000346947: OVO/U-SD Integration: Recurrence Pattern with Multiple Days Incorrectly 
Handled in OVO Outage File 
Limitation 

If a weekly recurrence pattern of a schedule element spans multiple days that are subsequent (for example, 
Sunday and Monday or Tuesday and Wednesday), only the schedule information of the first day is inserted 
in the outage file on the OVO Management Server. The outage for the remaining days is not inserted. 

Workaround 

None. 
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QXCR1000346948: OVO/U-SD Integration: Message Forwarded from Incident is Not 
Acknowledged when Incident is Closed 
Limitation 

When an Incident record in Service Desk has been manually forwarded to OVO via a smart action and 
created a message in OVO, this message is not acknowledged when the incident is closed in Service Desk. 

Workaround 

Acknowledge the OVO Message manually. 

MOM Integration 

This section describes known problems, limitations, and workarounds in the Microsoft Operations Manager 
(MOM) integration package of Service Desk. 

QXCR1000323681: MOM-SD Integration:  
Integration Account in OvObsLoadObject.conf Cannot Create Incidents  
Problem 

Integration account does not allow MOM messages to create incident records in Service Desk. 

Workaround 

Manually modify the OvObsLoadObject.conf file. Move the line with the entry SERVER to the line just 
below [OVOBSLOADOBJECT]. 

The delivered configuration file OvObsLoadObject.conf contains the following lines: 

[OVOBSLOADOBJECT] 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 

ACCOUNT=MOM_server1/Password4OpenV!ew 

SERVER=sdmanagementserverhostname 

PORT=30980 

MAPPING=ovowindows 

CLASSNAME=incident 

MODUS=insert 

Change the contents of the file to the following: 

[OVOBSLOADOBJECT] 

SERVER=sdmanagementserverhostname 

LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject.log 

ERROR_LOGFILE=C:\Program Files\HP OpenView\data\log\OvObsLoadObject_error.log 

ACCOUNT=MOM_server1/Password4OpenV!ew 

PORT=30980 

MAPPING=ovowindows 

CLASSNAME=incident 

MODUS=insert 

The line that contains the server tag is now at the top. This ensures that the SERVER tag is interpreted 
correctly. 

24 



QXCR1000330226: MOM-SD Integration 
Service Desk Database Rule Not Triggered 
Problem 

When an incident is set to state=closed, the database rule that sends an acknowledgement to the MOM 
consolidation server is not triggered. 

Workaround 

Create a dummy rule, save it and delete it. 

QXCR1000338961: MOM-SD Integration 
MOM: Hostname not mapped on search code in Incident. 

Problem 

The nodes that are monitored by MOM exist as Configuration Items in Service desk, but when MOM 
generates a new Incident record in Service Desk, the Configuration Item is not inserted in the Incident. 

Workaround 

Manually create the correct mapping as follows: 

1 Open the MOM import mapping under Data Exchange.  

2 Edit the Incident entity mapping. 

3 Select and open the Configuration Item attribute for mapping. 

4 Select Search Code in the Reference To field. 

5 Click OK to accept the new attribute mapping. 

6 Click OK to accept the Incident entity mapping. 

7 Save and close the MOM import mapping. 

Usability 

This section describes known usability problems, limitations, and workarounds in Service Desk. 

QXCR1000304079: OV Control 
Problem 

ovapacheA and ovobs processes abort after a reboot. 

Workaround 

After rebooting your system, restart the processes manually: 

ovc -start 

QXCR1000296194: Compound Schedule Entities 
Problem 

Schedule entities that include Compound Schedule entities are not supported as Service Hours or Planned 
Downtime. Only Schedules that include Schedule elements are supported. Compound Schedule entities 
including Compound Schedule entities are not correctly handled by SLM. 

Workaround 

None. 
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QXCR1000303777:  
Service Today 
Problem 

Automatic refresh does not work in the Service Today view. In the default filter pattern, a newly created 
Service Today view does not show any items.  

Workaround 

Use the Refresh button in the View menu to see the latest calls. 

QXCR1000290261: 
SQL Server Specific Errors: Cannot Create a Row of Size 14072 
Problem 

When you fill completely all the fields in a form when using SQL Server, you might get an error message 
when you try to save the form.  

Workaround 

Remove some information from the form. 

QXCR1000324111: 
In Web Console in Service Call SLA and Location Information are not Retrieved from Adding 
Caller 
Problem 

In the Web Console, in some cases a service and an SLA are not retrieved. The steps below describe the 
situation in which this problem can occur.  

To reproduce the problem, follow these steps: 

1 In the OV Configuration workspace, click System Settings. 

2 Double-click Service and SLA retrieval Settings for Service Call. The Service and SLA retrieval 
Settings for Service Call dialog box appears. 

3 In Automatic Service and SLA retrieval in Service Call, select from Caller, Caller Organization, 
and Service field. 

4 Add all the search criteria in the following order: Caller Organization hierarchy, Locations of 
Organization hierarchy, Caller, and Caller’s location. 

5 Select Stop the search if Services and SLA’s are found for a particular criterion. 

6 Select Enable Search and SLA retrieval from Caller Location field. 

7 Find the service level impact-priority mappings (click Data>Codes>Service Level>Impact Priority 
Configuration). 

8 Create a new default impact-priority mapping named DIPM, so that, for example, a low impact maps to 
a low priority. All impacts must be mapped to priorities. 

9 Click Data>Codes>Service call>Service call priority duration setting. 

10 Set the priority-duration settings from Top to Low priority: 1 hour, 2 hours, 4 hours, 6 hours, 8 hours, 
and so on.  

11 Click System Settings>General settings, and select the Application tab. 

12 Deselect Search Caller Person in Organization tree. 

13 By using the Default Support Hours field, do the following: 
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⎯ Create and relate a support hours schedule named SHDefault, with Sunday 00:00 to 08:00 as 
support hours 

⎯ Create a support hours schedule named SHA, with Sunday 12:00 to 00:00 as support hours 

⎯ Create a support hours schedule named SHB, with Saturday 12:00 to 00:00 as support hours. 

14 Add a Service Level workspace to a workspace group. 

15 Create a new service level named SLDefault, in which you relate the DIPM impact-priority mapping, 
and select Default. 

16 Create a service level named SL1 related to DIPM. 

17 Create a service level named SLB related to DIPM. 

18 Create two persons, and name them Caller1 and Caller2. 

19 Create an organization named Org. 

20 Make Caller1 and Caller2 members of Org. 

21 Create an organization named POrg, and set the child organization to Org. 

22 Create a business location named LoCaller, and relate persons Caller1 and Caller2 to this location (by 
using the Works at field). 

23 Create a business location named LocPOrg, and relate it to POrg (by using Hosted at). 

24 Create a service named SLocCaller, with receiver LocCaller. 

25 Create an SLA named SLALocCaller, relate it to SLocCaller, with receiver LocCaller, and relate 
service level SLB and support hours SHB (by using the Schedules field). 

26 Log in to the Web Console by using the system account. 

27 Create a service call, setting Caller to Caller1. 

Actual Results 

Service is not set. 

SLA is not set. 

Caller Location is not set. 

In the HP OpenView Console, everything works as expected. 

Expected Results 

Service set to SLocCaller, SLA set to SLALocCaller. 

Caller Location set to LocCaller. 

Workaround 

If the caller location is entered in a service call, the service and SLA values are retrieved immediately. 

This error occurs only when the service receiver is a location. If the service receiver is an organization, the 
function works according to expectations.  

Known Limitations 

This section describes the known limitations of this Service Desk release. 

1 You cannot include a schedule element in a schedule element. If you want to include a schedule element 
B in a schedule element A, you can achieve this by including (or excluding) the schedule elements in 
schedule element B. 
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2 Restriction because of defect QXCR1000306550. Users must set the Actual Start field to 00:00:00 when 
they create or update an SLA to prevent problems in the reporting. There are two problems: the first day 
is not displayed, or incorrect values are displayed (the values displayed are the values from the previous 
evaluation period). 

3 The installer on HP-UX does not use the argument -x mount_all_filesystems=false to install the 
SD-SLM packages. This means that if there are file systems declared in /etc/fstab, the installation 
fails with the following error: One or more filesystems that appear in the filesystem table are 
not mounted and cannot be mounted. You must modify the file /etc/fstab to be able to install SLM 
(remove one or more file systems).  

By design, the Software Distributor uses mount_all_filesystems=true as a default value.  Part of 
the reason for this is that filesystems may be mounted in the /opt/OV or /var/opt/OV rooted directory 
structure. Additionally, the /opt/OV or /var/opt/OV directory structure may contain symbolic links 
that reference other mounted file systems. 

4 Restriction because of defect QXCR1000241122. The LoadObject functionality in Service desk 5.0 
currently uses Perl version 5.6. Unfortunately, Perl 5.6 does not support Unicode, as a result of which all 
Service Desk functionality that uses LoadObject will not be able to handle Unicode dataflow properly. 
This issue impacts all integrations that use LoadObject, such as OVO for Windows and OVO for Unix. 

Product Co-existence 

This section describes known product co-existence problems, limitations, and workarounds. 

OpenView products may share the same component on specific systems. When you install an OpenView 
product on a system where another OpenView product is already installed, the installer first checks to see if 
the latest version of the shared component is installed. An older version of a component will be replaced by 
the latest version during the install process. Because of this, in some cases the component process scheduled 
for replacement, and other dependent components, will be stopped before installation. As a result, you may 
need to restart these stopped component processes after installation. For more information on restarting 
these component processes, refer to the relevant product documentation. 

The following examples illustrate the issue. 

OVO/W 7.21 and 7.5 
Problem 

When you install the Service Desk 5.0 client on a system where HP OpenView Operations for Windows 
(OVO/W) 7.21 or 7.5 Client is already installed, the OVO/W HP ITO Agent Windows Service stops. 

Workaround 

Restart the HP ITO Agent manually. 

OVO/U 7.1 
Problem 

When you install the Service Desk 5.0 client on a system where HP OpenView Operations for UNIX 
(OVO/U) 7.1 HP-UX Client is already installed, the OVO/U llbserver process stops. 

Workaround 

Restart the llbserver process manually. 
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OVO/U 8.1 
Problem 

When you install or uninstall the Service Desk 5.0 client, agent or OVO/U integration on a system where HP 
OpenView Operations for UNIX (OVO/U) 8.1 is already installed, the OVO/U ovcd process and the OVO/U 
agent stop.  

Workaround 

Restart the ovcd process and the OVO/U agent manually. 

The order in which you start the SD agent and the OVO/U agent is important. Start the SD agent first, and 
then start the OVO agent.  

If you try to start the SD agent when the OVO agent is already running, the SD agent might fail to start. In 
the log files, you will then repeatedly see these error messages:  

com.hp.ov.obs;WARNING;Unexpected null requester received and INFO;Obs Agent stopped.  

INFO;Stopped: Object Server Agent. 

Problem 

When you install or uninstall the OVO/U agent on a system where the Service Desk 5.0 Management Server 
is installed, the Service Desk processes stop. 

Workaround 

Restart the Service Desk processes manually with the command ovc –start. 

QXCR1000323328: OVO/W-SD and OVO/U-SD Integrations: 
Bbc Service Missing from 'opcagt' after Installing SD 5.0 Client 
Problem 

When the Service Desk 5.0 standalone client is installed on a machine where the OVO Agent is installed, 
running the opcagt -status command no longer displays the BBC Local Location Broker service. Do not 
be alarmed. The omission of this service from the list does not impact the behavior of the OVO Agent. 

Workaround 

None. 
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Accessibility Support 
HP is working to ensure that new HP OpenView management software releases comply with the latest 
international accessibility standards.  HP OpenView Service Desk 5.0 accessibility includes an improved 
user interface interaction model that allows screen readers to support users with visual impairments, and 
enhanced keyboard navigation as an alternative to mouse control.   

Product characteristics based on accessibility standards include:  

• No animations in the user interface 

• No requirement for user speech 

• Operability within a limited reach and strength 

• No requirements for simultaneous actions except as provided by the operating system 

• Consistent meanings of images  

• No flashing at a frequency where photosensitive epilepsy is a risk 

• Redundant coding of all audio signals as provided by the operating system 

• No requirements for timed responses 

• Consistent and well-defined focus and selection indicators 

• Alternative text for images 

• Redundant coding for use of color 

• Online help optimized for screen readers 

HP OpenView Service Desk 5.0 supports accessibility on Microsoft Windows operating systems using JAWS 
for Windows 4.5.  For a more detailed report of product compliance with Section 508 of the American 
Rehabilitation Act, go to the Check Product Accessibility web page at http://vgwh3pro.cce.hp.com/508/.  
From the Select Product Category drop-down menu, select Software and Operating Systems, then click Go.  
On the next screen, select product family HP OpenView Service Desk, then click Go. 

Accessible electronic manuals for this product can be requested from the HP OpenView Product Manuals 
web site at http://ovweb.external.hp.com/lpe/doc_serv/ by clicking the Send Feedback link near the 
bottom of the page, and specifying the product name, product version, operating system, and document 
names that you would like to obtain in fully accessible form.   

To activate accessibility support for Service Desk: 

1 After product installation, look in the following directory  

%INSTALLDIR%\nonOV\jre\1.4\lib\ext  

On Windows, the INSTALLDIR is the following: 

C:\Program Files\HP OpenView

Make sure the Sun Java 2 platform edition 1.4.x files are located in the following directory: 

⎯ jaccess-1_4.jar 

⎯ access-bridge.jar 

If the files are not in the correct directory, copy them from the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\AccessBridge\installer\installerFiles. 

2 Add the AccessBridge directory to your path: 

PATH=%INSTALLDIR%\nonOV\jre\1.4\AccessBridge;%PATH%  

This step ensures that the DLLs are part of the Java Access Bridge, and can be found and instantiated. 
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3 Make sure the accessibility.properties file is located in the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\lib directory.   

If needed, you can copy the file from the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\AccessBridge\installer\installerFiles 

The Java Virtual Machine (JVM) reads a number of property files as it starts up.   

4 Use each line in the accessibility properties file to enable different accessibility features.   

For example, to enable assistive technologies to use the Java Access Bridge, use a file editor to include 
the following line in the file: 

assistive_technologies=com.sun.java.accessibility.AccessBridge  

For additional properties examples and explanations (for example, how to set up screen magnifiers), 
refer to the Java Accessibility Utilities documentation: 

http://java.sun.com/products/jfc/jaccess-1.2/doc/examples.html

For more about configuring accessibility with Sun Java applications, refer to the following web site: 

http://java.sun.com/products/accessbridge/docs/setup.html. 

Integration with Other HP OpenView Solutions 
For information on the integrations in Service Pack 1, refer to the HP OpenView Service Desk Data 
Exchange Administrator’s Guide. 

Troubleshooting 
This section describes how to troubleshoot some problems in Service Desk. 

Installation Fails 

Problem 

The installation fails. 

Workaround 

If you installed the management server, examine the log file, server_HPOvInstaller.txt.  

The component log files are located in %OVDATADIR%, in the HPOvInstaller directory. The paths and 
file names are as follows:  

Windows 

%TEMP%\HPOvInstaller\server_<build number>, where <build number> is the version and build 
number, such as 5.00.742 

package_msi_<component>_install.log, where <component> is the name of the component 

UNIX 

/var/tmp/HPOvInstaller/server_<build number>, where <build number> is the version and build 
number, such as 5.00.742 

 31 

http://java.sun.com/products/jfc/jaccess-1.2/doc/examples.html
http://java.sun.com/products/accessbridge/docs/setup.html


package_depot_<component>_install.log, where <component> is the name of the component. 

These log files hold information about the native installation of the component. On a Windows platform, 
search in the log file for the word “Return Value 3”, which usually indicates there was an error. 

On HPUX, examine the swagent.log file located in /var/adm/sw/swagent.log.  

Examine the Object Server log file for information about why the installation failed. 

The Object Server log file is located in the following directory: 

%OVDATADIR%/log/system0.0_enUS 

This file contains the information from the Object Server and its tools. Look at the bottom of the file for any 
exception or other error message that might explain the failure. 

XPL Logging 

Problem 

You would like to change the way information is logged. 

Solution 

XPL logging uses the default Java logging.properties file. 

By default, this file is located in the following directory: 

C:\Program Files\HP OpenView\nonOV\jre\1.4\lib\logging.properties.  

For this file to work, you must execute the following once:  

ovconfchg -ns xpl.log -set logparent true 

For example, if you want all the logs to be written to the console, add the following lines to your 
logging.properties file:  

handlers=java.util.logging.ConsoleHandler 

java.util.logging.ConsoleHandler.level=INFO 

java.util.logging.ConsoleHandler.formatter=java.util.logging.SimpleFormatter 

In the logging.properties file, you can specify the logging level: 

• SEVERE 

• WARNING 

• INFO 

• CONFIG 

• FINE 

• FINER 

• FINEST 

Example: 

To specify finer logging for the Object Server, add the following to your logging.properties file: 

java.util.logging.ConsoleHandler.level=FINER 

com.hp.ov.obs.level=FINER 
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Object Server Cache 

Problem 

The Object Server cache can cause problems.  

Solution 

If you encounter a problem when you start the Object Server using ovc –start, try to delete the Object 
Server cache files by deleting all of the files in the following folder:  

C:\Program Files\HP OpenView\data\datafiles\obs 

Control Service Pid Files 

Problem 

You are unable to start the control service. 

Solution 

Execute the following command: 

del C:\Program Files\HP OpenView\data\tmp\*.* 

Console Does Not Show Any Workspaces 

Problem 

Your console screen does not display any workspaces. 

Solution 

Clear your user settings by executing the following command: 

del C:\Documents and Settings\%USERNAME%\Application Data\HP OpenView\*.* /s /q 
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Support 
Please visit the HP OpenView support web site at:  

http://www.hp.com/managementsoftware/support   

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers. 

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valuable 
support customer, you can benefit by being able to: 

• Search for knowledge documents of interest  

• Submit and track progress on support cases  

• Submit enhancement requests online 

• Download software patches 

• Manage a support contract  

• Look up HP support contacts  

• Review information about available services  

• Enter discussions with other software customers  

• Research and register for software training  

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract.  

To find more information about support access levels, go to the following URL:  

http://www.hp.com/managementsoftware/access_level  

To register for an HP Passport ID, go to the following URL:  

http://www.managementsoftware.hp.com/passport-registration.html

Legal Notices 
© Copyright 2005, 2006 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.  

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on 
all HP 9000 computers are Open Group UNIX 95 branded products. 

Java™ is a U.S. trademark of Sun Microsystems, Inc. 
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Microsoft® is a U.S. registered trademark of Microsoft Corporation. 

OpenView® is a registered U.S. trademark of Hewlett-Packard Company. 

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.  

Windows® is a U.S. registered trademark of Microsoft Corporation. 
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